
NS-Link™ Installation for Windows NT®

How to Use this Document
You can use the interactive Table of Contents to locate the information you need. There is also an Installation
Quick Start discussion for more experienced users.
Red, underscored items are links to URLs. Blue, underscored items are links within this document or to
another document on the media.
Note: If you copy this document from the ftp/web or CD and do not use the procedure discussed on the CD,

you will get an error message when selecting hyperlinks outside of this document.

NS-Link Requirements
This document discusses installing and configuring the NS-Link driver for the following hardware platforms
in the Windows NT 4.0 operating system:
• DeviceMaster™

Note: Use NS-Link if you want to use the ports as native COM ports. If you want to use serial tunneling or
socket mode, use the DeviceMaster RTS User Guide for configuration.

• RocketPort® Serial Hub ia
• RocketPort Serial Hub Si
The Comtrol device requires at least one host server running one of the following operating systems to install
NS-Link:

• Microsoft® Windows® NT 4.0, RAS or RRAS is required to support Remote Access Service and Microsoft
supports up to 256 RAS ports.

• Windows Terminal Server and Citrix® MetaFrame®

Note: The driver for the RocketPort Serial Hub Si is different than the driver for the RocketPort Serial
Hub and they are NOT interchangeable.

For hardware specific information or product information, see the hardware installation documentation that
is available on the Comtrol media (diskette or CD) shipped with your product or download the current version
from the ftp/web site.
• DeviceMaster 4/8-port
• DeviceMaster 16-port
• RocketPort Serial Hub ia
• RocketPort Serial Hub Si 2-port
• RocketPort Serial Hub Si 4/8-port
Driver updates can be downloaded at no charge from the Comtrol ftp/web site. Always check the web or ftp
sites to make sure that you have the current driver and documentation. Software downloaded from the ftp/
web site are self-extracting zipped files that you must extract before installing.

Connectivity Requirements
An ethernet connection, either to an Ethernet hub or to a network interface card (NIC) in the host server. See
the hardware installation documentation (above) for information regarding hardware installation.
If you are connecting a RocketPort Serial Hub Si or RocketPort Serial Hub ia directly to the server NIC card,
an ethernet crossover cable is required (see the Hardware Installation documentation).
If you are connecting a DeviceMaster directly to the server NIC card, connect an ethernet cable to the port
labeled DOWN. If connecting a DeviceMaster to an ethernet hub, connect an ethernet cable to the port labeled
UP.
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IP or MAC Addressing Issues
This is an overview of IP and MAC addressing issues that may affect how you configure the Comtrol device
with a brief discussion of advantages of either method.
The IP addressing scheme has the following advantages:
• Uses an industry standard protocol.
• Allows you to configure servers to use ports on the Comtrol device that are outside of the host server’s

Ethernet segment.
Note: This IP address must be a unique reserved IP address, do not use an address from a dynamic address

pool. If necessary, see the system administrator for an IP address.
The MAC addressing method has the following advantages:
• Simplifies implementation and ongoing support by eliminating the address administration issues

inherent in network protocols. MAC addresses are predefined by Comtrol and there is no potential for an
“address conflict” at setup.

• It is isolated from foreign LAN segments, which minimizes potential security issues.

Using SNMP (RPSH-Si 4/8-Port, Only)
To configure SNMP for the RocketPort Serial Hub Si 4/8-port, use the Diagnostic and IP Configurator utility.
This utility is delivered on the Comtrol media shipped with your product or available on the ftp/web sites.
The Hardware Installation documentation (also on the Comtrol media) provides you with information about
how to use the Diagnostic and IP Configurator utility.
Note: For SNMP configuration on other models, see the ftp/web site for availability.

Using the Port Sharing Feature
The Comtrol device can be shared with multiple servers on a network. To do so, follow the Installing NS-Link
discussion for each server that you want to permit access to the serial ports.
You can implement the port sharing feature in several ways. You can share the same port with multiple
servers or you can set up multiple servers to share specific ports on the Comtrol device.

Note: Most applications do not release ports, so you may not be able to use port sharing across multiple
servers with the same port. Also, if using port sharing, make sure that two computers do not try to access
the same port at the same time. Only one computer can control a given port at a given time.

NS-Link Installation - Quick Reference
If you are familiar with installing Comtrol software, you can use the following procedure as a quick reference:
1. Install the hardware.
2. If necessary, unzip the self-extracting NS-Link files.
3. If necessary, remove the existing NS-Link driver.
4. Install NS-Link and the configure the port characteristics in NS-Link setup.
5. Shut down, restart the server and program the IP address into the device.
6. Connect your serial devices.

Comtrol Device
Port 1

Server A Server B

Port 2

COM 5 COM 6

Port 3 Port 4

COM 5 COM 6

Ethernet Hub

Configured for Server A Configured for Server B

Example:
To configure two ports for Server A and two ports for Server B, you could configure the drivers like this:
1. When installing NS-Link on Server A, select “Not Configured” for the COM port names for Ports 3 and 4.
2. When installing NS-Link on Server B, select “Not Configured” for the COM port names for Ports 1 and 2.

COM port names must be unique to each server.
Multiple servers can use the same COM port names.
IP or MAC Addressing Issues 2



Interactive Table of Contents
How to Use this Document ............................................................................................................................... 1
NS-Link Requirements ..................................................................................................................................... 1
Connectivity Requirements .............................................................................................................................. 1
IP or MAC Addressing Issues........................................................................................................................... 2
Using SNMP (RPSH-Si 4/8-Port, Only) ........................................................................................................... 2
Using the Port Sharing Feature ....................................................................................................................... 2
NS-Link Installation - Quick Reference .......................................................................................................... 2

NS-Link Installation and Configuration ......................................................................... 5
Removing an Existing Driver ........................................................................................................................... 5
Installing NS-Link ............................................................................................................................................ 6
Programming the IP Address ......................................................................................................................... 14
Verifying the Installation ............................................................................................................................... 18
Changing Configuration Parameters ............................................................................................................. 19
Adding Devices After the Initial Installation................................................................................................ 21
Replacing NS-Link Devices ............................................................................................................................ 22

NT Configuration Overview ............................................................................................. 23
Configuring Modems....................................................................................................................................... 23

Working with NT RAS.............................................................................................................................. 23
Installing Modems.................................................................................................................................... 23
Further Modem Configuration ................................................................................................................ 25

Installing and Configuring RAS..................................................................................................................... 26
Installing RAS Initially............................................................................................................................ 26
Adding or Reconfiguring a RAS Device ................................................................................................... 27

Configuring Printers....................................................................................................................................... 30
Adding Serial Printers ............................................................................................................................. 30
Changing Printer Port Configuration...................................................................................................... 32
Changing Printer Port Assignment ......................................................................................................... 32

Troubleshooting and Using Comtrol Tools ................................................................... 33
Troubleshooting ........................................................................................................................................ 33
Using Test Terminal ................................................................................................................................. 34

Testing a Comtrol Device................................................................................................................... 34
Testing a Comtrol Device (RS-485) ................................................................................................... 35
Test Terminal Modem Control Signals ............................................................................................. 35

Using Port Monitor ................................................................................................................................... 35
Starting Port Monitor ........................................................................................................................ 36
Changing Screen Appearance ........................................................................................................... 36
Column Setup..................................................................................................................................... 37
Report Configuration ......................................................................................................................... 37
Port Monitor Files .............................................................................................................................. 38
Port Monitor Variables....................................................................................................................... 38

Using Peer Tracer..................................................................................................................................... 40
Starting Peer ...................................................................................................................................... 40
Log Functions ..................................................................................................................................... 40
Using Peer .......................................................................................................................................... 40
Other Peer Commands....................................................................................................................... 41
3



Using the Device Advisor ......................................................................................................................... 41
Device Advisor Driver Messages ....................................................................................................... 43

Technical Support ........................................................................................................................................... 44
4



NS-Link Installation and Configuration

This subsection discusses the following installation and configuration issues:
• Removing an existing driver
• Installing the software
• Verifying the installation
• Program the IP addresses
• Changing configuration parameters
• Adding additional Comtrol devices to an existing configuration
• Replacing devices

Removing an Existing Driver
Use the following procedure to remove the existing driver. If updating (not reconfiguring) NS-Link, make sure
that you remove the existing version before installing an updated driver.
Note: Using the Remove button on the Comtrol Main Setup sheet only discards the software configuration, it

does not remove the software.
1. Right-click on the Network Neighborhood, and select Properties.
2. Select the Adapters tab.
3. Highlight Comtrol NS-Link and select the Remove button.

4. Click Yes to the delete this item query.
5. Click Close. Several screens display as the system

updates.
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When the updates are complete, this message
displays:

6. Click Yes to shut down and restart the server, so
that your changes take effect.

After removing the existing driver, use the following
subsection to install a new version.

Installing NS-Link
Use the following procedures to install NS-Link for Windows NT 4.0 operating systems.
Note: If updating NS-Link, first remove the existing version of NS-Link. Do not use the Update option.
The following procedures assume that you have already:
1. Installed the hardware.
2. Determined that the hardware is working properly.

3. If necessary, unzip the self-extracting files from the Comtrol media or ftp/web site.
Note: The self-extracting zip file name has this format: 180####.exe. Double-click on the file name and

follow the Winzip wizard. Extract NS-Link files to a diskette or create a subdirectory on your hard
drive and extract the files.

Model Status

DeviceMaster

1. The PWR LED on the front of the unit is lit, indicating you have
power and it has completed the boot cycle.

2. The red LNK/ACT LED is lit, indicating that you have a
working Ethernet connection.

3. The red 100 LED is lit, indicating a working 100 MB Ethernet.
4. After connecting the serial devices, the yellow Rx LED shows

that the data receiver is connected to another RS-232 device or
receiving data in RS-422/485 mode. The green Tx LED shows
that the data is transmitting.

RocketPort Serial Hub ia

1. The yellow PWR LED is lit, indicating you have power and that
the device driver has been downloaded to the device.
Note: If the PWR LED is still flashing, this means that the

driver has not downloaded to the device.
2. The green LNK LED is lit, indicating that you have a working

Ethernet connection.
3. The yellow ACT LED flashes, indicating Ethernet activity on

the network.

RocketPort Serial Hub Si
2-port

1. Both 10/100BASE-T LEDs should be lit.
2. The Power LED in the front of the unit should lit.

Note: If the Power LED is still blinking on the RPSH-Si, this
indicates that NS-Link did not download.

RocketPort Serial Hub Si
4/8-port

1. The lower 10BASE-T LED should be lit (if using a 10Base-T
Ethernet connection).

2. The Port LEDs on the front of the unit should be cycling their
lights approximately every 30 seconds (instead of the Port 1
LED flashing, which indicates that the RPSH-Si is waiting for
NS-Link to be downloaded).
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4. Right-click on the Network Neighborhood, and select Properties.
The following screen appears.

5. Select the Adapters tab and click on the Add button.
6. Select the Have Disk button.

If installing NS-Link from a diskette, insert the diskette.
7. Enter the drive and directory path to the installation files and

click on the OK button. For example, if you extracted NS-Link
to a subdirectory named comtrol, enter:

c:\comtrol

Note: This screen shot illustrates installing NS-Link
from the default installation directory.

8. Click on the OK button when the selection box appears
with Comtrol NS-Link highlighted.
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9. Select the Next button when the Add Device Wizard
appears:
Note: The Add Device Wizard also contains help for

each screen.

10. Select the Comtrol device you are installing.
11. If queried, select the number of ports on this Comtrol

device.

12. Select the starting COM port number for each port
you plan to use on this server, if you do not want to
allow access to a specific port for this server, scroll up
to Not configured. When configuring ports among
several servers, they can share the same COM port
name or be assigned a unique COM port name on
each server.
Note: This screen is dependent on the number of

ports on the device.
13. If this is the initial NS-Link installation and you

have not programmed an IP address into the device,
select MAC. If the device has been previously
programmed with an IP address, you can select IP.
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Note: If you want to use the device in an IP
networking environment, you must first install
NS-Link with a MAC address and then
configure the IP address using the IP
Programming tab in the NS-Link Device
Properties screen.

a. If you selected MAC. enter the MAC Address of
the device that you are installing and click on the
Next button.

Note: The MAC address label is on the device and
the format is: 00 c0 4E xx xx xx. A space must
separate each two digits, as illustrated in the
following screen shot.

If your site has other Comtrol network devices
on the network, their MAC addresses will
display in the droplist after initial
installation.

b. If you selected IP, enter a unique reserved IP
address or a qualified domain name (DNS) and
select the Next button.

Note: If using DHCP or ARP, the administrator
must reserve the MAC address of the Comtrol
device to the IP address assigned to the device.
If necessary, see your system administrator for
a unique reserved IP address or qualified
domain name.

14. Click on the Finish button when the following screen
appears:
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The Device Properties screen appears after selecting the Finish button.

Note: If you select IP address in the previous screen, the screen is similar to the MAC version displayed.
15. Optionally, rename the NS-Link default name.
16. Verify the Number of Ports on the device.
17. Verify the Network Address.
18. Select the OK button. The NS-Link Setup screen appears.
19. If you want to enable Verbose mode for Windows NT error

messages or select a scan rate, click on the Options tab.
The Device Options screen appears.

a. Select the options you want to implement.
Note: Typically, you should leave the scan rate set to the default value (10 ms) for most applications. To

adjust latency for time-critical applications, select a longer or shorter interval from the droplist, or
type in the rate. Changes to Scan Rate do not take effect until you restart the server.

b. Click on the Main Setup tab.
Installing NS-Link 10



20. Highlight the COM port that you want to configure and
select the Properties button.
The COM Properties screen appears:

21. Select the appropriate mode to match the peripheral that you are connecting to that particular COM port.
22. Optionally, make any necessary changes to fit your environment:

a. Lock the baud rate to access higher or lower rates than are normally permitted by your Windows NT
applications.

b. Set a time delay on the transmit data before a port closes.
Note: You can select the length of time to wait for data to clear the transmit buffer, before a host

application closes the port. If data is still in the transmit buffer, you can set a delay time to
allow the buffer to empty. This is typically used with slower peripheral devices such as printers,
to give the data sufficient time to flush through the system.

c. Set an inactive timeout period for the device.
Note: Specifies the amount of time (seconds) that interface to the server can have no activity before the

device releases the lock and allows another host server to acquire the port. If you enter fractional
seconds, the timeout value re-sets to zero. Zero means that the port never times out.

d. Map 2 stop bits to 1.
Note: You can use this option to map 2 stop bits to 1 bit. If the application you are using is hard coded

to use two stop bits and you are receiving framing errors, you can implement this option. Leave
this box unchecked to enable stop bits to pass through unchanged.

e. Wait for physical transmission before completing write.
Note: Use this option to force all write packets to wait until the transmit data has physically

completed the transmission before returning completion to the host application. The default
mode (box not checked) is to buffer the data in the transmit hardware buffer and return
completion as soon as the packet is in the buffer.

f. Emulate modem hardware ring signal.
Note: This emulates a hardware RI (ring indicator) signal.

g. Clone port settings.
Note: If this box is checked, the changes you make in the COM Properties screen are applied to all

NS-Link ports in the system. If this box is not checked, the changes you make to the Port
Setup options apply to the selected port only.
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h. If you need to configure RTS options, click on the RTS
Toggle tab.

i. Configure the port and select OK after making the
appropriate selections.
The Override and lock to RTS toggle mode option
allows you to lock the port in RTS toggle mode, then
set the mode (low or high) as desired.
The RTS Toggle RTS Low option allows you to toggle
the RTS output signal low during data transmission. If
the option box is not checked, RTS is toggled high
(asserted) during data transmission.

23. After configuring your port (COM) properties, click on the
OK button. The Main Setup screen returns.

24. If you did not clone all the COM ports, repeat Steps 20
through 23 until all of the COM ports that you want to use
are configured.

25. Click on the Ok button after you have configured each
port.

26. To add another NS-Link device, highlight the first device
and click the Add button. Follow Steps 9 through 25 to
complete installation.

27. Select Yes to the following query.

28. Click on the OK button.
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29. Select the Add button if you want to add a device (from another
manufacturer) at this time or the Close button in the Network
window. See Adding Devices After the Initial Installation to
install multiple Comtrol devices.
Note: You must configure at least one valid NS-Link Device.
The Windows NT system updates the bindings.

Another advisory message displays and the Comtrol Program
Group appears.

30. Close the Comtrol Program Group.

31. Select Yes to shut down and restart the server.
Note: Initial installation is not complete until

you have rebooted the server.
32. After rebooting, perform the appropriate

procedure for your installation:
MAC Addressing
• Verify that the installation was successful

using Verifying the Installation (Page 18).
• Connect your serial devices to the Comtrol device. If you need information about connecting your serial

devices, see the appropriate hardware installation documentation for your product.
- DeviceMaster 4/8-port
- DeviceMaster 16-port
- RocketPort Serial Hub ia
- RocketPort Serial Hub Si 2-port
- RocketPort Serial Hub Si 4/8-port

• Set up modems, RAS, or printers.
IP Address
Go to the Programming the IP Address discussion to program the IP address into the Comtrol device.
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Programming the IP Address
After installing NS-Link and restarting the system, use the following procedure to program the IP address in
the Comtrol device.
Note: To perform the following procedure, you must have previously entered the MAC address in the Device

Setup tab and rebooted your system.
See your System Administrator to acquire a unique reserved IP address if you are using DHCP. They will
need the MAC address of the unit to provide you with an IP address.
1. Go to the Start button and select Programs/Comtrol NS-

Link/Comtrol Hardware Setup. The Setup screen appears:
2. Highlight the device name of the unit you want to

program and select Properties.
3. Uncheck the MAC box and then check the IP checkbox.

4. Select the IP Programming tab.
5. Select the Retrieve button to check to see if the

Comtrol device has been programmed with an
IP address, gateway, and subnet mask.

6. Select the Ok button to retrieve the values.
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7. If NS-Link retrieves the values assigned by
the System Administrator, this means that the
hardware has been previously configured and
go to Step 16.
Note: The default address for the DeviceMaster

is 192.168.250.250.
If NS-Link returns all zeros, go directly to Step
8.
If NS-Link did not retrieve the correct values
(not zeros), select the Clear button.

a. Select the Ok button when this message
displays:

b. Select the Ok button when this message
displays:

c. Select the Reset button and wait until the device reloads.
8. Enter the IP address, subnet mask, and gateway values in the IP Settings area.

9. Select the Program button and then the Ok button when this message displays:
10. Select the Ok button when this message displays:
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11. Delete the contents of the IP Address, Gateway, and Subnet Mask fields.

12. Select the Retrieve button.

13. Verify that the information that loads into the
IP Address, Gateway, and Subnet Mask fields
matches the information that you previously
entered. If not, re-enter the IP Address,
Gateway, and Subnet mask information and
repeat Steps 9 through 12.

14. Perform the appropriate procedure:
• If you are operating this device in a DHCP

or ARP environment, select the Clear
button.

• If you are operating this device in MAC
mode, select the Disable button.

15. Select the Reset button to soft boot the device.
Note: The Comtrol device cycles its LEDs.
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16. Select the OK button to this message.

Select the Ok button to close the Device screen.
17. Select the Ok button:

18. Reboot the server.
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Verifying the Installation
After rebooting the system, NS-Link downloads to the Comtrol device. The following provides you with LED
conditions that indicate whether NS-Link has downloaded to the device.

You can also use the following procedure to verify NS-Link installation.
1. Open the Event Viewer.
2. Review the messages in the log.

If the installation was successful, there is a log entry for the device stating that NS-Link was successfully
initialized.
Note: This message is only meaningful if the hardware LED diagnostics pass.
If the installation fails, a Stop Event Log entry for the device states that there was a problem and NS-Link
did not load.

Read over the system log in the Event Viewer. If the event log states it could not connect with the device,
check the device as outlined in Troubleshooting. In addition, you can use the following applications to help
diagnose the problem in Windows NT:
• Using Test Terminal
• Using Port Monitor
• Using Peer Tracer
• Using the Device Advisor
You can also select the Verbose EventLog option under the Main Setup Options tab in NS-Link, which may
help you determine the problem. See Step 19 (Page 10) in the Installing NS-Link discussion for more
information.

Model Status

DeviceMaster

1. The PWR LED on the front of the unit is lit, indicating you have
power and it has completed the boot cycle.

2. The red LNK/ACT LED is lit, indicating that you have a
working Ethernet connection.

3. The red 100 LED is lit, indicating a working 100 MB Ethernet.
4. After connecting the serial devices, the yellow Rx LED shows

that the data receiver is connected to another RS-232 device or
receiving data in RS-422/485 mode. The green Tx LED shows
that the data is transmitting.

RocketPort Serial Hub ia

1. The yellow PWR LED is lit, indicating you have power and that
the device driver has been downloaded to the device.
Note: If the PWR LED is still flashing, this means that the

driver has not downloaded to the device.
2. The green LNK LED is lit, indicating that you have a working

Ethernet connection.
3. The yellow ACT LED flashes, indicating Ethernet activity on

the network.

RocketPort Serial Hub Si
2-port

1. Both 10/100BASE-T LEDs should be lit.
2. The Power LED in the front of the unit should lit.

Note: If the Power LED is still blinking on the RPSH-Si, this
indicates that NS-Link did not download.

RocketPort Serial Hub Si
4/8-port

1. The lower 10BASE-T LED should be lit (if using a 10Base-T
Ethernet connection).

2. The Port LEDs on the front of the unit should be cycling their
lights approximately every 30 seconds (instead of the Port 1
LED flashing, which indicates that the RPSH-Si is waiting for
NS-Link to be downloaded).
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Changing Configuration Parameters
Use the following procedure to change the:
• NS-Link properties, such as:

- Name of the Comtrol device
- Number of ports being used by this host server
- Network address
Note: You can change the network address type by clicking on the current checkbox type, followed by

placing a check in the other network type and entering the appropriate address. If replacing
hardware, you have to change the MAC address. If necessary, see Programming the IP Address.

- Device options, for example, Verbose mode or using a scan rate.
• COM port properties, such as the port mode (RS-232, RS-422, or RS-485) and application-related options

discussed in Step 22 of the installation process.

Before changing the communications mode in NS-Link for an existing port, make sure
that you disconnect the peripheral device from the port.

Use the following procedure to change configuration parameters.
1. Click Start/Programs/Comtrol NS-Link/Comtrol Hardware Setup.
2. To change the NS-Link properties for the device (name,

number of ports, or network address) highlight the device
name and select the Properties button.

3. Make the desired changes and select the OK button.

Caution
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4. To change device options (Verbose mode or scan rate),
click on the Options tab, make the changes, and toggle
back to the Main Setup tab.

5. To change port configuration, highlight the COM port that
you want to change and select Properties.

6. Make the port configuration changes and select the Ok
button.

Note: Before changing the communications mode in
NS-Link for an existing port, make sure that you
disconnect the peripheral device from the port.

If you change the mode of the port, the following query
appears:
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7. Click OK to save your configuration changes.
Note: Depending upon the type of configuration changes you

made, you may or may not need to reboot your system.
The driver will prompt you to save the changes, if
necessary.

8. Select Yes to complete NS-Link installation.

9. Click on the OK button to the following query.

Adding Devices After the Initial Installation
Use the following procedure to add more NS-Link Comtrol devices to an existing installation.
1. Connect the new device to the network and power it up.
2. Make sure that the device passes the power-on LED diagnostics.
3. Click Start/Programs/Comtrol NS-Link/Comtrol Hardware Setup.
4. Click on the Add button.

The Add Device Wizard appears.

5. For help with the remainder of the setup, use Installing
NS-Link and start with Step 9.

6. Reboot the system so that the new device initializes.
Adding Devices After the Initial Installation 21



Replacing NS-Link Devices
On occasion, it may be necessary to replace an existing and configured Comtrol device with an identical
device, without downing the server or reconfiguring ports. To do so, follow these steps:
1. Shut off the old device, connect all cables to the corresponding ports on the spare device, and power up the

new device.
Make sure that you re-cable the spare exactly like the original. A remote chance exists that
you could damage a peripheral if it is incorrectly connected to a port configured for the wrong
communications mode.

2. Write down the Network (MAC) Address of the spare device on the customer service label provided.
3. Click Start/Programs/Comtrol NS-Link/Comtrol Hardware Setup.
4. Highlight the name of the NS-Link device that you want

to swap out and click the Properties button.
5. Enter the new network (MAC or IP) address of the new

Comtrol device.

Note: Leave all other properties the same.
6. If necessary, program the IP address.
7. Click OK to exit the Device window and click OK to exit NS-Link Setup screen.
8. Click OK to save the new configuration.
The new device immediately replaces the old one under the old device’s device name.
Note: Restarting the system is not needed.

Caution
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NT Configuration Overview

Configuring Modems
After installing the hardware and driver for Windows NT, you can use this discussion to configure modem
COM ports.
The Comtrol devicecan support any asynchronous serial modem for use by any application that uses TAPI.
For information regarding port pinouts and signals, see the Hardware Installation documentation:
• DeviceMaster 4/8-port
• DeviceMaster 16-port
• RocketPort Serial Hub ia
• RocketPort Serial Hub Si 2-port
• RocketPort Serial Hub Si 4/8-port

Working with NT RAS
Comtrol products are frequently used to provide Dial-Up Networking access with NT RAS (Remote Access
Service).
• If RAS is not installed, note that you must install at least one RAS-capable device (for example, modem)

before installing and configuring RAS.
• If RAS is installed, note that the modem installation process automatically launches RAS Setup after

modem installation is complete.

Installing Modems
The following instructions were developed using Comtrol modem products. If you are using another brand of
modem, note that some prompts and screen descriptions may differ from those shown.
Follow these steps:
1. Connect the modem to the desired port.
2. Power up the modem.
3. Open the Control Panel window.
4. Double-click the Modems icon.

If you have no other modems installed, skip to Step 5.
If you have already installed another modem, the Modems
Properties window displays. Click the Add button.

5. Check the “Don’t detect my modem...” box and click Next.
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Note: While Windows NT can automatically detect modems, we advise against using this option as auto-
detect feature may cause some multiprocessor systems to lock up, and the modems may be installed
in reverse order.

6. Select the appropriate manufacturer and
model and click OK. If the correct
manufacturer and model do not appear on the
list, click Have Disk to install software from a
manufacturer-supplied installation diskette.

7. Select Finish. The modem software is installed
on the selected ports.

Depending on prior configuration, you may be asked to enter your country of use, area code, the number
you dial to get an outside line, and whether you have tone or pulse dialing at this time.
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8. If you need to configure modem properties (maximum
baud rate, data bits, parity, and so on), click the Properties
button, make the needed changes, then click OK to return
to this window.

Note: For help configuring modem properties, see the
Windows Help System.

9. If you need to configure dialing properties (country, area
code, calling card number, and so on), click the Dialing
Properties button, make the needed changes, then click OK
to return to this window.

10. Click Close.

Further Modem Configuration
At this point:
• If you are not using RAS, you are now finished. Reboot the

server so that your changes take effect and resume normal
operations.

• If you plan to use RAS but do not have it installed yet,
reboot your system, then go to Installing RAS Initially.

• If you already have RAS installed and configured, this
dialog box displays.

If you do not want to configure this modem for use with RAS at this time, click No, then reboot and resume
normal operations.
If you do want to configure this modem for use with RAS, do not reboot. Instead, click Yes, then go directly
to Adding or Reconfiguring a RAS Device

Installing and Configuring RAS
After installing the hardware and driver, and installing and configuring at least one RAS device (for example,
a modem), use this section to install and configure Remote Access Service (RAS).

Installing RAS Initially
If you have not previously installed RAS in your Windows NT server, log into the server with Administrative
rights and follow these steps:
Note: This example shows how to install and configure RAS for use with modems, but you can use it as a

guide to setting up other serial devices.
1. Open the Control Panel and start the Network applet, or right-click on the Network Neighborhood and

select Properties. The following screen displays:
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2. Select the Services tab and click the Add button.
3. Highlight Remote Access Service and click the OK

button.

4. Enter the location of the Windows NT files (for
example, d:\i386) and press the Continue button.

The appropriate files are copied onto your hard drive.
The RAS installation process automatically launches the Add
RAS Device process. Go to Adding or Reconfiguring a RAS
Device, Step 5.

Note: If you install or reinstall RAS from your original Windows
NT 4.0 distribution media, you must install or reinstall the
latest Windows NT Service Pack after installing/
reinstalling RAS. This is necessary because most Service
Packs include RAS-related files that are newer than the
files on the NT distribution media.

Adding or Reconfiguring a RAS Device
There are several different ways to start this procedure:
• If you have previously installed RAS and configured at least

one RAS device, and are now adding or reconfiguring RAS devices, begin with Step 1.
• If you have previously installed RAS and were in the process of installing a modem when this process

started automatically, begin with Step 3.
• If you were in the process of installing RAS when this process started automatically, begin with Step 5.
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Follow these steps:
1. Open the Control Panel and start the Network applet, or right-click on the Network Neighborhood and

select Properties. The Network window displays.

2. Select the Services tab.
3. Highlight Remote Access Service and click the Properties

button. The Remote Access Setup window displays:

4. To reconfigure an existing RAS port, highlight the port/
device and click the Configure button. Then go to Step
7.

5. To add a new RAS device—for example, if you are
configuring a new modem—click the Add button. The
Add RAS Device window displays:

6. Use the droplist to select the COM port (modem) that
you want to configure and click the OK button.
Note: If no modems appear on this list, you need to

install a modem, see Installing Modems.
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The Remote Access Setup window displays
again.

7. Highlight the desired COM port (Modem)
and click the Configure button. The Configure Port
Usage window displays.

8. Select the appropriate radio button, based on the role
the modem will perform, and click the OK button.
Note: When configuring multiple simultaneous RAS

dial-in ports, configure the ports to “Receive calls
only” not “Dial out and Receive.” Configuring a
port to dial-out requires a separate memory pool
for each dial-out port, while all ports configured
for receive-only share the same memory pool.

If you configure too many ports for dial-out unnecessarily, resources can become an issue. If you
require dial-out on the RAS server, configure one port to “Dial out and Receive” and all the other
ports to “Receive calls only.”

The Remote Access Setup window displays
again.
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9. Highlight the COM port (modem) again and click the Network
button.

10. Select the appropriate dial out protocols, dial in protocols,
logon security levels, enable multilink (if required) and click
OK.
Note: Only previously configured protocols are selectable. If

you want to set up a protocol that is grayed out, you
must first add it using the Network Protocols tab.

If you selected “Receive calls only” on all ports while
configuring the port usage, the “Dial out Protocols” area will
be shaded.
If you want to use Multilink PPP (bonding), make sure that
you click the Enable Multilink checkbox.
For detailed information about the configuration screens, use
the Help button or the Windows NT CD-ROM (Support/books/
server.hlp file to locate information).

Note: The following steps are dependent upon the protocol
selections made in this screen.

11. If you select NetBEUI on the Network Configuration screen,
the following window displays. Make the appropriate
selection for your environment and click OK.

12. If you select TCP/IP, the following window
displays. Make the appropriate selections
for your environment and press OK.

13. If you select IPX, the following window
displays. Make the appropriate selection for
your environment and press OK.

14. Click OK to exit the Network Configuration
screen and return to the Remote Access Setup screen.

Note: Choices made during network configuration will effect the entire system.
15. If you want to duplicate the configuration you just created on any other COM port (modem), highlight the

COM port number and click Clone. Otherwise, repeat Steps 7 through 14 for each COM port (modem) you
want to set up.
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16. After setting up all the COM ports, click the Continue button.
17. Click the Close button at the Network/Services tab to complete the RAS installation.
18. Click Yes when asked to reboot the computer.

Windows NT RAS installation is complete.
19. If necessary, install the latest NT Service Pack or Packs from Microsoft.

Configuring Printers
Use this subsection to configure printers for the Comtrol device after installing the hardware and NS-Link.

Adding Serial Printers
Follow these steps to configure a serial printer in Windows NT:
1. Connect the printer to the desired port. Use a DTE-to-DTE null modem cable unless the printer maker

specifies otherwise.
2. Open the Printers control panel and double-click on the Add Printer icon.
3. Click the My Computer checkbox, then the

Next button.

4. If the desired COM port is on this screen,
select it, click on the Next button, and skip to
Step 6.

5. If the desired COM port is not on this list,
click the Add Port button and follow these
steps:
a. A list of printer ports is displayed. Click

Local Port.
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b. Click New Port.
c. Type in the name of the port.
Note: Port names above COM9 require the \\.\ prefix. For example, to reference COM12, enter \\.\COM12:

(make sure that you add the colon)
d. Click the OK button.
e. Click the Close button to return to the Add Printer Wizard.
f. Click the Next button.

6. Select the printer make and model and click the Next button.

If your printer is not on the make and model lists, but you have a manufacturer-supplied printer diskette,
click the Have Disk button.
If you have already installed another printer using this driver, you are asked if you want to keep the
existing driver.

7. To keep NS-Link: check Keep existing driver, click Next, and go to Step 8.
If you choose Replace existing driver, or if you have not previously installed this driver, you are prompted to
insert either the Windows NT CD-ROM or the manufacturer’s printer diskette. Do so and click Next.
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8. Select whether you want this printer to be the
Windows NT default printer, and click on the
Next button.

9. Select whether or not you want to share this
printer with other computers on the network.
If you select Shared, you are asked to indicate
the operating systems of all the computers
that will be sharing this printer. (You may also
be required to insert the operating system
media so that Windows NT can extract the
necessary driver files.)

10. Select whether to print a test page and click
on the Finish button.
You are now ready to begin using the printer.
No reboot is needed.

Changing Printer Port Configuration
If the printer does not successfully print the test
page, it may be necessary to change the port baud
rate, parity, and so on. If the Ports applet does not configure the port properly, you may have to use the mode
command from a DOS prompt. Also, check the printer for DIP switches or other hardware configuration
options.

Changing Printer Port Assignment
To change the port assigned to a printer, follow these steps:
1. Open the Printers control panel.
2. Right-click on the icon for the printer you want to change.
3. Select the Properties option from the menu. The Properties window is displayed.
4. Click the Ports tab.

Note: The Properties window also gives you access to printer test and setup options that can be very
helpful when debugging a serial printer installation.

5. Check the port you want to switch to. Remember to change your cabling accordingly.
Note: The Configure button on the Ports tab does not recognize Comtrol ports. This is a limitation of

Windows NT. If you need to reconfigure the port, use the Ports option on the Control Panel.
6. Click on the OK button. Any changes you make take effect immediately. No reboot is needed.
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Troubleshooting and Using Comtrol Tools

The first subsection discusses troubleshooting. The following subsections discuss the following utilities that
are shipped with Comtrol drivers for Microsoft operating systems:
• Test Terminal (WCOM32.EXE)
• Port Monitor (PORTMON.EXE)
• Peer Tracer (PEER.EXE)
• Device Advisor

Troubleshooting
If you are having trouble with a Comtrol device, try the following.
Note: Most customer problems reported to Technical Support are traced to cabling or network problems.
1. Verify that the unit is powered on.

• If the unit has a power switch, turn the unit’s power switch off and on, while watching the LED
diagnostics. If it is a RocketPort Serial Hub Si 4/8-port unit, run the diagnostics program.

• If the unit does not have a power switch, disconnect and reconnect the power cord.
2. Verify that the port polarity is correct, see the appropriate documentation:

• DeviceMaster 4/8-port
• DeviceMaster 16-port
• RocketPort Serial Hub ia
• RocketPort Serial Hub Si 2-port
• RocketPort Serial Hub Si 4/8-port

3. Verify that you are using the correct types of cables in the correct places and that all cables are tightly
connected.

4. If you are using a 10/100mb NIC card with a RocketPort Serial Hub Si (4/8-port), try locking the card to
10mb/s.

5. Verify that the Ethernet hub and any other network devices between the server and unit are powered up
and operating.
Note: To isolate the unit from the network:

DeviceMaster: move the cable from the port labeled UP to the port labeled DOWN and connect the
other end directly to the PC network interface card.

RPSH-ia and RPSH-Si: use an Ethernet crossover cable to connect the unit directly to the server
NIC.

6. Verify which servers are having problems controlling the device.
7. Verify that the network (MAC) address in NS-Link matches the address on the Comtrol device. See

Changing Configuration Parameters to see how to do this.
8. Verify that the network IP address is correct. If IP addressing is being used, the server should be able to

ping the Comtrol device.
9. Enable the Verbose Event Log feature under the Setup Options tab and then reboot the server.
10. Verify that you are addressing the port correctly. In many applications, device names above COM9 require

the prefix \\.\ in order to be recognized. For example, to reference COM20, use \\.\COM20 as the file or
port name.

11. Use the Test Terminal program (wcom32.exe) to troubleshoot communications on a port-by-port basis.
12. Use the Port Monitor program (portmon.exe) to check for errors, modem control, and status signals. In

addition, it provides you with raw byte input and output counts.
13. Use the Peer Tracer program (peer.exe) to trace driver events.
14. Use the Device Advisor to help identify the problem.
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15. If you have a spare Comtrol device try replacing units. If this corrects the problem, the Comtrol device you
have removed from service may be in need of repair.

16. Remove and reinstall NS-Link.

Using Test Terminal
WCOM32 is a terminal program that enables you to open a port, send characters and commands to the port,
and toggle the control signals.
Note: WCOM32 will not work on ports used by RAS if Remote Access Service is running or any other

application is using the port. If you are using RAS, you must stop the service before starting WCOM32
to test RAS COM ports. To test ports that are not used by RAS, you do not need to stop RAS.

Follow these steps:
1. To start WCOM32, select Test Terminal from

the Comtrol program group. The program
window displays:

2. Select Open Port from the Port menu. A list
of possible COM port numbers displays.

3. Select the COM port you want to test.
If the COM port does not exist or if it is
currently being used by another program, a
Create File Error message displays.
If the COM port is available, a terminal window
pops up:

Note: Notice the <loop> button in the terminal
window. If this option is activated, it is green
and uppercase ( ), the COM port internal
loopback feature is activated, and the data is
returned by the COM port hardware. If this
option is deactivated, it is gray and lowercase
( ), the internal loopback is deactivated,
and the data is sent out the COM port.

Testing a Comtrol Device
1. Place a loopback plug on the COM port you are

testing. Make sure all connectors are seated firmly
and that the loop button is off.
RocketPort Serial Hub Si (4/8-ports only): this works only for RS-232 and RS-422 mode. Use the
diagnostics for RS-485 mode.

RocketPort Serial Hub Si (2-port) and RocketPort Serial Hub ia: This works only for RS-232 mode.
To build loopback plugs, see the appropriate hardware documentation:
• DeviceMaster 4/8-port
• DeviceMaster 16-port
• RocketPort Serial Hub ia
• RocketPort Serial Hub Si 2-port
• RocketPort Serial Hub Si 4/8-port

2. From the Port menu, select Send Test Data. The program sends out a repeating data stream.
Note: To stop the data stream, select Send Test Data again.
• If the loopback plug is in place and the port is working correctly, the test data should be echoed back

to the screen.
• If the loopback plug is not in place or the port is not working correctly, no data or garbled data is echoed

back to the screen.
Note: If no characters appear, try putting the loopback plug on an adjacent port. It may be that you have

the ports mixed up.
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3. If further testing is required, select Loopback Test from the Port menu.
If the loopback plug is in place and the port is working
correctly, the system should return the message “Passed.”
If the loopback plug is not in place or the port is not
working correctly, the system will return the message
“Failed.”

Testing a Comtrol Device (RS-485)
Perform the following procedure to determine if a port or
ports are functioning properly.
1. Connect a straight-through cable from Port 1 to Port 2.

Note: See the appropriate Hardware Installation documentation if you need to build a cable:
• DeviceMaster 4/8-port
• DeviceMaster 16-port
• RocketPort Serial Hub ia
• RocketPort Serial Hub Si 2-port
• RocketPort Serial Hub Si 4/8-port
If testing ports other than Ports 1 and 2, simply connect the cable between any two ports.

2. Open a session for each port.
3. Enter data into the Port 1 session, the data should appear in the Port 2 window.
4. Enter data into the Port 2 session, the data should appear in the Port 1 window.

Note: If the data appears as described in Steps 3 and 4, the hardware is functioning properly.

Test Terminal Modem Control Signals
The terminal window displays the modem control signals as gray or green lights at
the top of the window. The first four are inputs:
The lights are green if they are turned on, or gray if off. The text on the light also
changes from uppercase (CTS), which is on, to lowercase (cts), which is off.
The next two lights are outputs:
Note: If you have a loopback plug connected and you click on one of the outputs, the corresponding signal is

sent to the input and the input lights should toggle accordingly.
The rightmost light is the loop indicator:
If this is on, the COM port internal loopback feature is activated and any information or code entered in the
terminal window loops back through the COM port circuitry. If this is off, the COM port internal loopback is
deactivated, and any information or code entered in the terminal window is sent out of the port.

Using Port Monitor
The Port Monitor program (portmon.exe) offers a summary of all Comtrol device statistics in one spreadsheet
view. It also enables you to verify operation of all Comtrol device ports from a single window.
The Port Monitor display follows the familiar spreadsheet model: each COM port is a horizontal row, and each
vertical column displays a variable or value for the respective COM port. For definitions of the abbreviations
used, see the Port Monitor Variable List.
Port Monitor can also produce statistics and reports that can help you verify the operation of the COM ports
and connected peripherals. Some immediate feedback includes:
• The state of the modem control and status signals
• Open ports
• Raw byte input and output counts obtained from NS-Link
• Port errors
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The available statistics include:
• Instantaneous characters per second (CPS) calculations
• Minute, hour, and day CPS averages and peaks
• Carrier detect (CD) signal runtime and transition count
Reports can be automatically generated on an hourly and/or daily basis, and can cover all ports collectively or
a separate report for each port. You can also set how often the values are recalculated, fine-tuning
thoroughness against system efficiency, and automatically run external batch files to perform additional
processing and analysis.

Starting Port Monitor
To run Port Monitor, select Port Monitor from the Comtrol program group.
The monitor window displays:
Note: To change the appearance of the

screen, see the following discussion.
Once the monitor window displays, Port
Monitor is active and collecting data. If any
cumulative data has been saved from
previous sessions, it is automatically brought
in and used.
Port Monitor continues to run and collect
data until you terminate it, at which point all
accumulated data is automatically saved for
use in the next session.

Changing Screen Appearance
While Port Monitor is running, there are a number of commands and controls that change the appearance of
the screen.

* The Reset command does not clear raw data from the calcs.dat file. It simply resets the selected display fields
to their null values. For more information regarding calcs.dat see Page 38.

Port Monitor Screen Commands

Desired Change Procedure

Change the monitor window font. Select Font from the Edit menu.

Change width of a single column. Left-click on the column separator (vertical) line and drag it to the
desired width.

Change column placement. Left-click in the middle of the column you want to move and drag it
to the desired location.

Remove a column. Right-click on the column you want to remove and select Remove
from the pop-up menu.

Clear all fields and reset them to null
values.

Right-click on the upper left cell in the table and select Reset from
the pop-up menu.*

Clear any single field except the upper
left cell.

Right-click on the field to be cleared and select Reset from the pop-
up menu.*

Add a column.

Right-click on the column now occupying the desired location and
select Add from the pop-up menu.
You are prompted to name the variable you want to display, as well
as other information. (See Column Setup, below.)
After you click OK, the column is inserted in the selected location
and the existing column is moved to the right.

Change other properties of a column. Right-click on the column and select Properties from the pop-up
menu. (See Column Setup, below.)
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Column Setup
When you select Add or Properties from the column pop-up menu,
the Column Setup window displays:
• Use the Input droplist to select the variable displayed in the

column.
• Use the Type droplist to select the way in which the value

displays: either as an integer, as an on/off state, as an integer
with a kilo, mega, or giga suffix, or as an hh:mm:ss time stamp.
This defaults to the appropriate type for the selected Input
variable.

• Use the Name variable to change the column heading name.
• Use the Width variable to specify the column width in

characters.
• Use Color0 to set the column character color when the value is

zero.
• Use Color1 to set the column character color when the value is

not zero.
• When done, click OK to save your changes and return to Port Monitor.

Report Configuration
To configure reports, select Config from the Edit menu.
The Single report options cover all ports and are
overwritten each time the reports are generated. The
Multiple report options generate a separate report for
each port, and each report file is appended each time
the report is generated.
For Hour reports, use the Single and Multiple droplists
to select whether you are generating single or multiple
reports, or both. For each report type, select from the
following types of data to include:
• None: no report is generated.
• Hour Data: only variables with “Hour” in the name

are included.
• All Data: all variables are included.
• View Data: only variables that appear on-screen are

included.
The External Program field is used to enter a command line to run another program after the hourly reports
have been generated. For example, you can use this to run a batch file that performs custom report
processing. The Test button causes the command line to be executed immediately.
For Day reports, the single and multiple droplists behave the same, but your choices are:
• None: no report is generated.
• Day Data: only variables with the words “Day” or “Raw” in the names are included.
• All Data: all variables are included.
• View Data: only the variables that appear in the Port Monitor window are included.
Likewise, the External Program field is used to enter a command line to be executed after the daily reports
have been generated.
The Update Time option allows you to set the rate at which the port information is obtained and the
calculations performed. There is a trade-off between Port Monitor efficiency and response time. If you are
using Port Monitor to view the port activity on the screen, you may want to set the update time to 1 or 2
seconds, so that the screen is updated frequently. If you are concerned about the monitor program using CPU
resources, set this to a higher value, (6 to 20 seconds) in order to decrease the time required by the program to
perform the calculations and update the screen.
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If Port Monitor is left active to generate reports, minimizing or reducing the display area of the program will
help reduce the CPU overhead of updating the screen.

Port Monitor Files
Port Monitor creates and uses the following files:
• portmon.vew

• calcs.dat

The default column layout is saved in portmon.vew. If you have been experimenting with the appearance of the
monitor screen, you can use the File menu Save option to save your customized layout in another.vew file. You
can retrieve this file later by using the File menu Open option, or you can use the Edit menu View Default
option to retrieve portmon.vew and restore the default view.
All Port Monitor calculations are saved at program exit and on the hour in a binary file named calcs.dat. This
enables you to halt Port Monitor execution without losing accumulated data.
Port Monitor also creates a \REPORTS directory. All hourly and daily reports are saved in this directory,
under the following names:
• hall.txt — hourly single report
• dall.txt — daily single report
• hcomx.txt — hourly multiple reports, where x is the port number
• dcomx.txt — daily multiple reports, where x is the port number
Caution: Since multiple reports append new data each time they are written, the multiple report files grow in

size. It is up to you to delete them periodically.
Some safeguards are built into the program to avoid filling up a hard disk drive due to growing report files.
The monitoring program stops writing additional data to the multiple reports if they reach a size of 2 MB.
Also, the program will not write out data files to the disk drive if the spare room on the drive is less than 2
MB in size.
To view or edit an hourly or daily report, use the Edit Report option on the File menu, or use a system tool
such as NOTEPAD.
For more information, see the Port Monitor Help file.

Port Monitor Variables
The following table lists Port Monitor variables.

Port Monitor Variable List

Variable Description

Open Open status, on if open, off if closed.

Cts Input CTS pin status.

Dsr Input DSR pin status.

Cd Input CD (carrier detect) pin status.

Rts Output RTS pin status.

Dtr Output DTR pin status.

TxTotal Total bytes transmitted.

RxTotal Total bytes received.

TxCPSInst Instantaneous average of transmit characters per second.

RxCPSInst Instantaneous average of receive characters per second.

Errors Total hardware receive errors (parity, framing, and overruns.)

TxMinCPS Last minute average of transmit characters per second.

RxMinCPS Last minute average of receive characters per second.

TxCPSMinAvMax Peak TxCPSInst for the last minute.
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RxCPSMinAvMax Peak RxCPSInst for the last minute.

TxCPSHourAvMax Peak TxMinCPS for the last hour.

RxCPSHourAvMax Peak RxMinCPS for the last hour.

TxCPSDayAvMax Peak TxMinCPS for the last day.

RxCPSDayAvMax Peak RxMinCPS for the last day.

TxTotalRaw Total number of transmit bytes raw data from NS-Link.

RxTotalRaw Total number of receive bytes raw data from NS-Link.

TxMinCnt Count of transmit bytes sent in last minute.

TxHourCnt Transmit bytes count sent in the last hour.

TxDayCnt Transmit bytes count sent in the last day.

RxMinCnt Receive bytes count sent in the last minute.

RxHourCnt Receive bytes count sent in the last hour.

RxDayCnt Receive bytes count sent in the last day.

TxMinCntWrk Transmit bytes count sent in this minute.

TxHourCntWrk Transmit bytes count sent in this hour.

TxDayCntWrk Transmit bytes count sent in this day.

RxMinCntWrk Receive bytes count sent in this minute.

RxHourCntWrk Receive bytes count sent in this hour.

RxDayCntWrk Receive bytes count sent in this day.

TxCPSMinAvMaxWrk Peak TxCPSInst for the current minute.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.

TxCPSDayAvMaxWrk Peak TxHourCPS for the current day.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.

RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.

RxCPSDayAvMaxWrk Peak RxHourCPS for the current day.

CDRuns Carrier detect turn-on count.

CDDayRuns Carrier detect turn-on count in the last day.

CDDayRunsWrk Carrier detect turn-on count in the current day.

CDRunTime Time in seconds carrier detect has been on.

CDHourRunTime Time in seconds carrier detect has been on in the last hour.

CDDayRunTime Time in seconds carrier detect has been on in the last day.

CDHourRunTimeWrk Time in seconds carrier detect has been on this hour.

CDDayRunTimeWrk Time in seconds carrier detect has been on this day.

StatusFlags Bit flags, Open, CTS, DSR, CD, RTS, DTR

TxPkts Raw count of total transmit packets sent.

RxPkts Raw count of total receive packets sent.

OverrunErrors Total count of receive overrun errors.

FramingErrors Total count of receive framing errors.

Port Monitor Variable List (Continued)

Variable Description
Configuring Printers 39



Using Peer Tracer
The Peer Tracer program (peer.exe) is specifically designed to view the internal operations of NS-Link for the
purpose of troubleshooting communications on Windows NT systems. Peer enables you to see:
• Receive and transmit data
• Internal driver event traces
• Advanced configuration and status information
Like Test Terminal, Peer acts as a simple terminal session, and is used to send and receive text information to
and from NS-Link. To use Peer, you type in commands, and status and information are sent back.
Unlike Test Terminal, Peer enables you to keep a continuous log of the commands sent and the results
received in a file named peer.log.
Comtrol Technical Support may ask you to run Peer in order to help diagnose reported problems.

Starting Peer
Peer Tracer does not appear in the Comtrol
program group. To use it, you must open Windows
Explorer, access the C:\WINNT\system32\rpshSi
directory, and double-click on peer.exe. The Peer
Tracer window displays:

Log Functions
All logging functions are found under the File
menu. To start keeping a log, select Log to Disk from
the File menu. The other options on this menu are
View Disk Log, Clear Disk Log, Clear Screen, and Exit.

Using Peer
To use peer, simply type in commands at the : prompt. (It may be necessary to press Enter to make the :
prompt appear.) For example, to examine COM5, type:

PORT COM5 <Enter>

To gather some information about the port, type:
STAT <Enter>

This should return details about the port.
To turn on monitoring of any calls into driver (events), type:

MON EV <Enter>

To send strings and commands to attached peripherals—for example, to send “ATH0” to a modem—type:
SEND ATH0 <Enter>

A return and linefeed are always appended to each string sent.

ParityErrors Total count of receive parity errors.

OverrunErrorsRaw Total count of receive overrun errors, from NS-Link.

FramingErrorsRaw Total count of receive framing errors, from NS-Link.

ParityErrorsRaw Total count of receive parity errors, from NS-Link.

Port Monitor Variable List (Continued)

Variable Description
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Other Peer Commands
Enter commands at the : prompt and follow each command with Enter.

Keep in mind that all commands are processed in NS-Link, and that Peer simply acts as a conduit for this
information.
For more information, see the Peer.hlp help file.

Using the Device Advisor
You can use the Device Advisor to determine the following information:
• Summary of the device status
• The MAC address of the network interface card (NIC)
• The Adapter ID string
• The Comtrol device’s MAC address
• Detailed state of the Comtrol device
• Total number of successful load attempts
• Total number of devices on the network
• Transmit statistics, such as the number of:

- Frames out
- Packets to device
- Retransmitted frames

• Receive statistics, such as the number of:
- Frames accepted
- Frames passed on
- Packets from device
- Out of sequence frames

Note: For detailed information about the fields in the Device Advisor, use the on-line help available in the
application.

Peer Tracer Commands

Command Effect

MON TX Monitor data being transmitted through the selected port.

MON RX Monitor data being received through the selected port.

M Turn off all monitoring.

? Display Peer Tracer command summary.

PORT COMxx Change port being examined to COMxx.
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Use the following procedure to access the Device Advisor:
1. Start the NS-Link menus using the Start button.
2. Highlight the device that you want to review and select

the Properties button.
3. Click on the Device Advisor tab.

The Device Advisor screen appears providing you with information that you may find useful.
Note: For information about the fields in the Device

Advisor, use the on-line help available in the
application.
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Device Advisor Driver Messages
The following tables provide information about device driver summary messages and reported state
messages.

Driver Summary Messages

Message Description

Unintialized Comtrol device has not been installed correctly.

Unable to contact the RPSH Si
NT driver

The Comtrol device NS-Link is not installed or is not responding to
Device Advisor requests.

Unable to contact a Network
Interface Controller (NIC)

The server NIC card may not be installed, may be malfunctioning, or may
not be bound to the Comtrol device.

Cannot detect network No inbound traffic of any sort Comtrol device may be inoperative or you
may have a network cabling problem.

Cannot detect any RPSH-Si.
Network traffic is being received, but not from a Comtrol device. Check
the network connections and verify that the Comtrol device is powered
up.

Cannot detect RPSH-Si with
specified MAC address.

Network traffic is being received from a Comtrol device, but not the one
specified in Device Setup. Check the device to make sure that you are
using the correct MAC address in Device Setup, and check the Main
Setup window to verify that you are working with the correct device.

RPSH-Si device with specified
MAC address was detected, but is
not configured for this server.

Either the Comtrol device in question is not assigned to this server, or it
is not assigned to any server, or it has been configured for this server but
the configuration has not been saved. If the latter, return to the Setup
window, save and exit, and restart the server

RPSH-Si device detected and
configured for this server, but is
not yet assigned to this server.

Either the Comtrol device is currently being controlled by another server
or the device power has been cycled and the device is waiting for a server
to acquire it.

RPSH-Si detected, initializing. The server has acquired the Comtrol device and is downloading the
control program. The device will be available shortly.

RPSH-Si responsive, but no data
traffic exchange since last inquiry.

The Comtrol device appears to be installed correctly and active, but no
data traffic has been sent or received since the last time you clicked the
Refresh button. If there should have been traffic, check the Comtrol
device port configuration and external cabling.

RPSH-Si responsive; data traffic
received, but nothing sent since
last inquiry.

Similar to above, except the Comtrol device has received data
successfully.

RPSH-Si responsive; data traffic
sent, but nothing received since
last inquiry.

Similar to above, except the Comtrol device has sent data successfully.

RPSH-Si active. Normal state: the Comtrol device is installed correctly and active with
data traffic.

Poor connection to RPSH-Si.
This message displays if retransmissions occur, frames arrive out of
sequence, or more than 2% of the total packets arrive out of sequence.
This generally indicates a cable, connector, or LAN termination problem.

Counts reset. This message displays immediately after you click the Reset button.
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Technical Support
Comtrol has a staff of support technicians available to help you. You should review Troubleshooting and
Using Comtrol Tools before calling Technical Support.

In addition, please have the following information available.

* The hardware serial number and MAC address can be found on printed tags the unit.
Comtrol supplies a self-adhesive label with each Comtrol Device, which you can use to record the serial
number and network address. If the Comtrol device is not in a readily accessible location, check to see if this
label has been filled out and posted elsewhere (for example, near the server console.

Driver Reported State Messages

Message Description

Invalid An illegal Comtrol device state has been detected. Reset the Comtrol device.

Init This is the normal state for undetected and inactive Comtrol device.

InitOwn The server has acquired the Comtrol device but has not downloaded the control software.

SendCode The server has acquired the Comtrol device and is in the process of downloading the
control software.

Connect The server has completed the download and is completing initialization.

Active The normal state for a Comtrol device that is attached to an NT server and is ready for
data traffic.

Not found The specified MAC address is not configured on this NT server.

Undefined No Comtrol devices are configured on this NT server.

Comtrol Headquarters Europe
Phone (763) 494-4100 +44 (0)1869 323220
FAX (763) 494-4199 +44 (0)1869 323211

Email support@comtrol.com support@comtrol.co.uk
Web

support Searchable Solution Database and FAQs

Web site www.comtrol.com www.comtrol.co.uk
FTP site ftp.comtrol.com

Support Call Information

Item Information

Hardware Type

Hardware Serial Number*

MAC Address*
(if using MAC addressing) 00 C0 4E ____ ____ ____

Operating system type

Driver part number and revision level

Server computer make, model, and speed

Other network devices and network (MAC) addresses

Devices connected to the Comtrol device
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Disclaimer and Copyrights

Copyright © 1999-2001. Comtrol Corporation.
All Rights Reserved.
First Edition, May 26, 2001
Comtrol Corporation makes no representations or warranties with regard to the contents of this guide or to
the suitability of the Comtrol products for any particular purpose. Specifications subject to change without
notice. Some software or features may not be available at the time of publication. Contact your reseller for
current product information.

Trademarks
RocketPort is a registered trademark and Comtrol is a trademark of Comtrol Corporation.
DeviceMaster and NS-Link are trademarks of Comtrol Corporation.
Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation.
Citrix and WinFrame are registered trademarks of Citrix Systems, Inc.

Other product names mentioned herein may be trademarks and/or registered trademarks of their respective
companies.
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